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[bookmark: _Toc516648434][bookmark: _Toc11147450][bookmark: _Toc103933623]Release Notes
This document contains shared release notes and planned changes. Shared release notes and planned changes document features and changes that apply to SAP Concur solutions site-wide or to multiple SAP Concur products and services. They include but are not limited to:
· Security-related features and changes such as annual security certificate renewals and changes in support for security ciphers and protocols
· Site-wide UI features and changes such as changes to the home page, changes to the site header or footer, or the implementation of new site-wide UI themes
· Sign-in process features and changes such as the addition or removal of sign-in features, URL changes, and domain name changes
· Production and test environment features and changes
· Global settings or administration page features and changes such as the addition of new site-wide settings or changes to the design of the administration pages
· Changes to processes such as where and when release notes are published
For New Features and Changes that apply to a single product and/or service see the release notes for that product or service. Links to the product and service-specific release notes can be found on the following pages:
Professional Edition
Standard Edition
Small Business Edition
[bookmark: _Toc103933624]Concur Invoice Vendor Management
[bookmark: _Hlk100911074][bookmark: _Toc103933625]Vendor Page Custom Fields and Invoice Copy-Down Options

	Information First Published
	Information Last Modified
	Feature Target Release Date

	April 15, 2022
	May 13, 2021
	May 19, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933626]Invoice | Standard		                            
Overview
When custom fields are created, they are added to the following pages:
· User Profile: On the user profile page
· Concur Expense: On the expense report header, line, and allocation pages
· Concur Invoice: On the invoice page header, line, and allocation pages 
· Concur Request: On the request header and allocation pages
With the May release, new custom fields are also added to the following pages:
· Concur Invoice New Vendor page 
· Concur Invoice Vendor pages
In addition, a new Invoice Copy-Down option has been added to the Custom Fields page. This option enables admins to change the copy-down source for custom fields on invoices enabling them to choose whether custom fields should copy from the user profile to the Invoice Header or from the vendor record to the Invoice Header.
Business Purpose / Client Benefit
This change enables admins to add custom fields to Concur Invoice vendor pages and specify the copy-down source for custom fields in Concur Invoice.
Admin Experience
After this change is implemented, when a client admin adds a custom field through the Custom Fields page in Product Settings, the field is added to the New Vendor page when a vendor manager or end user creates new vendors, and on the vendor information page for existing vendors.
To add a custom field:
Click Administration > Invoice Settings > Custom Fields.
[image: ]
Click Add Custom Field.
[image: ]
Select a field type, select or enter a field name, and then click Add.
[image: ]
The visibility and access attributes (required, optional, and read-only) for custom fields on the User, Concur Expense, Concur Invoice, and Concur Request pages is configurable. Custom fields on the vendor pages are set to Optional by default and this attribute cannot be changed.
Depending on the type of field you create, there may be additional steps required to complete creation of the field. For detailed steps, refer to Shared: Custom Fields Setup Guide for Concur Standard Edition.
Set the copy-down behavior for the new field:
1. On the Custom Fields page, click Switch to Advanced View.
[image: ]
In the Invoice Copy-Down list, select the desired copy-down source.
[image: ]
If you change the copy-down source of a custom field, the following informational message appears at the top of the Custom Fields page:
"Any invoices created after the Invoice Copy-Down setting is changed will inherit the new copy-down source. Any previously created invoices will not be impacted."
[image: ]
The message can be closed by clicking the "x" in the upper right corner of the banner.
Click Save.
If an admin changes the copy-down source for a field to a new custom field on the vendor page, only invoices created after the new custom field is added will copy-down from the new custom field. Invoices created before the new custom field was added will continue to copy-down data from the previously targeted field.
To view the custom field on the New Vendor page:
1. Click Invoice > Vendor Manager.
[image: ]
Click Open Vendor > Request New Vendor.
[image: ]
The custom field is included on the New Vendor page.
[image: ]
The custom field is also included on the page for existing vendors.
[image: ]
Custom Fields Created before the feature was implemented
Custom fields created before this change is implemented will not automatically be added to the vendor page. The admin must first visit the Administration > Invoice Settings > Custom Fields page. Visiting the Custom Fields page prompts the system to add the preexisting custom fields to the vendor page.
Configuration / Feature Activation
This change occurs automatically.
[bookmark: _Toc103933627]Custom Fields
[bookmark: _Toc103933628]Two 'How It Works' Links Removed 

	Information First Published
	Information Last Modified
	Feature Target Release Date

	May 13, 2022
	--
	May 21, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933629]Expense, Invoice, Request | Standard
Overview
With the May release, in preparation for future improvements, the How It Works links on the Custom Fields > Add New Field and Custom Fields > Edit List pages will be removed.
Business Purpose / Client Benefit
Removal of the How It Works links and the related content are a first step toward implementing more functional improvements to the Custom Fields pages in Product Settings.
Admin Experience
The How It Works links will no longer be available on the following pages:
Add New Field
Before
[image: ]
After
[image: ]
Edit List
Before
[image: ]
After
[image: ]
Configuration / Feature Activation
This change occurs automatically.
[bookmark: _Toc103933630]File Transfer Updates
[bookmark: _Toc93580783][bookmark: _Toc103933631]**Ongoing** Rotating PGP Key for File Transfers

	[bookmark: _Hlk92987153]Information First Published
	Information Last Modified
	Feature Target Release Date

	February 2021
	May 13, 2022
	January 15, 2021 and October 11, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93580784][bookmark: _Toc103933632]Travel, Expense, Invoice, Request, Intelligence | Professional & Standard
Overview
Files transferred to SAP Concur products must be encrypted with the SAP Concur public PGP key, concursolutionsrotate.asc. 
concursolutionsrotate.asc 
· Key file is available in client’s root folder
· Key ID 40AC5D35
· RSA 4096-bit signing and encryption subkey
· Key expires every 2 years
· Client is responsible for replacing the key before it expires
Next expiry date: September 4, 2022
The new rotating public PGP key (concursolutionsrotate.asc) will be available in the client’s root folder on June 4, 2022.
The SAP Concur legacy PGP key (key ID D4D727C0) will be decommissioned on October 11, 2022. You must switch to using the rotating PGP key before that date. Files encrypted with the legacy PGP key will not be processed after October 10, 2022.
This announcement pertains to the following file transfer DNS endpoints:
· st.concursolutions.com
· mft-us.concursolutions.com
· vs.concursolutions.com
· st-eu.concursolutions.com
· mft-eu.concursolutions.com
· AWS transfer endpoints (when they are communicated to you)
Business Purpose / Client Benefit
The rotating public PGP key provides greater security for file transfers.
Admin Experience
An administrator with the required file transfer credentials can log into the file transfer site to retrieve the rotating public PGP key, concursolutionsrotate.asc, from the root directory.
Configuration / Feature Activation
Your internal file transfer administrator can add the key to their PGP keyring and start using it to encrypt any files being transferred to SAP Concur. 
If assistance is required, please contact SAP Concur support.
For more information, refer to the Shared: File Transfer for Customers and Vendors User Guide.
[bookmark: _Toc103933633]Home Page
[bookmark: _Toc103933634]**Ongoing ** SAP Concur Homepage Changes

	Information First Published
	Information Last Modified
	Feature Target Release Date

	December 4, 2020
	May 13, 2022
	Q4 2021 – Future Release

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933635]All Products | All Editions
Overview
[bookmark: _Hlk19876476][bookmark: _Hlk19876428]In Q4, 2021, SAP Concur began redirecting clients to a new homepage. The appearance of the new homepage is identical to the previous SAP Concur homepage. The new homepage has enhanced functionality when services become temporarily unavailable.
The roll out of the new homepage is phased:
Phase 1: In October of 2021, SAP Concur began redirecting Concur Expense, Concur Invoice, and Concur Request clients in the US Datacenter to the new homepage. 
Phase 2: In December 2021, SAP Concur began redirecting Concur Expense, Concur Invoice, and Concur Request clients in the EU Datacenter to the new homepage.
Phase 3: At a date to be determined, SAP Concur will begin redirecting the remaining clients in the US and EU datacenters to the new homepage. The remaining clients include those with Concur Travel standalone or Concur Travel with Expense, Invoice, and/or Request.
Business Purpose / Client Benefit
This change ensures that the SAP Concur homepage is available even when some services are unavailable and improves the consistency of the sign in experience.
End-User Experience
With the old homepage, when a user signs into their SAP Concur products, they see their homepage.
The appearance of the homepage varies depending on which products and services are enabled for the client and the permissions assigned to the user.

If some products or services are unavailable while other products and services are up and running, a modified version of the user’s homepage similar to the following appears: 
[image: ]
After a client is migrated to the new homepage, if one or more services are unavailable, when a user signs in to their SAP Concur products, they will see the usual homepage, but if the user navigates to a page for a service that is unavailable, they will see a page similar to the following:
[image: ]
After migration to the new homepage, if all services are available, this change is transparent to the user and they see a homepage that is identical to the pre-migration homepage.
Example Homepage

Configuration / Feature Activation
This change occurs automatically; there are no configuration or activation steps.
[bookmark: _Toc103933636]Miscellaneous
[bookmark: _Toc103933637]**Ongoing** SAP Concur Migration to Cloud Platform in AWS

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 18, 2022
	March 18, 2022
	Ongoing in 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933638]All Products | All Editions
Overview
SAP Concur plans to migrate from a pure private cloud operation, where all equipment is owned by SAP Concur, to a cloud platform. We plan to close our own private data centers in favor of a cloud platform implemented in Amazon Web Services (AWS). While this process started in 2017, we are focused on the final phase of the migration in 2022 for the North American and EMEA data centers.
Business Purpose / Client Benefit
This change provides a stronger security posture, improved performance and stability, and faster innovation for our clients.
End-User Experience During Migration
While a company is being migrated from an SAP Concur private data center to the cloud platform, their SAP Concur solutions might not be available to end users. 
If an end user attempts to sign in to SAP Concur solutions during the active migration process, they might not be able to sign in and they might see the following message:
"SAP Concur solutions is undergoing scheduled maintenance. Please try again later"
[image: ]
If an end user is working in SAP Concur solutions when their company is migrated, they might be returned to the sign in page.
SAP plans to implement migrations on weekends and after business hours. 
Configuration / Feature Activation
This change will occur automatically.
For details, refer to the SAP Concur Cloud Platform Strategy FAQ.
[bookmark: _Toc103933639]Profile Settings
[bookmark: _Hlk101180469][bookmark: _Toc103933640]**Ongoing** Accessibility Improvements to My Profile – Personal Information Page

	Information First Published
	Information Last Modified
	Feature Target Release Date

	April 22, 2022
	May 13, 2022
	Q2 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933641]Travel, Expense | Professional & Standard
Overview
To make the My Profile – Personal Information page in Profile Settings more accessible to users, SAP Concur is making changes to the page. Implementation of the changes began with the April 2022 release and will continue over time.
With the May release, the following changes are being implemented in the Assistance and Travel Arrangers section of the My Profile – Personal Information page:
· Table headers will be added to the display table.
· Tags, labels, and captions will be added to support the user of screen readers.
· Minor changes will be made to facilitate tabbing between elements.
With the April release, the following changes were implemented in the Credit Cards section of the My Profile – Personal Information page:
· Table headers were added to the display table.
· Tags and captions were implemented to support the use of screen readers.
· Minor changes were made to facilitate tabbing between elements.
Business Purpose / Client Benefit
SAP Concur is committed to making our products accessible to as many users as possible. With that goal in mind, we plan to make changes to the My Profile – Personal Information page that will improve the user experience for users who don’t use a mouse and for users who use screen readers.  
End-User Experience
With the May release, the Assistants and Travel Arrangers section now includes the following column headers:
· Assistant
· Can Book Travel?
· Update/Delete 
[image: ]
Configuration / Feature Activation
The changes are implemented automatically.
For more information about accessibility improvements, refer to Accessibility Updates.
[bookmark: _Toc103933642]**Ongoing** Changes to My Profile, Home Page, and Profile Menu

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 21, 2022
	May 21, 2022
	Ongoing beginning in April 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933643]Travel, Expense, Invoice, Request, Mobile | Professional & Standard
Overview
SAP Concur has implemented or plans to implement changes to several pages in the UI. The changes will be implemented over time beginning in April of 2022 and continuing throughout 2022. 
These changes reflect SAP's commitment to supporting gender diversity by enabling gender non-binary users to enter consistent information when making travel arrangements and entering information in SAP Concur solutions. Changes include but are not limited to the following:
April 2022 Release
· The greeting on the SAP Concur Home page was removed. In addition, first and last name were removed from the menu in the SAP Concur mobile app.
· If a user adds their preferred name on the My Profile – Personal Information page in Profile Settings, their preferred name and last name is displayed in the SAP Concur Profile menu.
May 2022 Release
· The Nickname field on the My Profile – Personal Information page will be changed from Nickname to Preferred Name.
· The Nickname field in the Employee Travel Addendum Import 350 file will be changed from Nick Name to Preferred Name.
· The Nickname field in the Employee Import file will be changed from Nickname to Preferred Name.
Future Releases
· The Nickname field on the User Administration – User Details page will be changed from Nickname to Preferred Name.
· A new option, Mx, will be added to the Title list on the My Profile – Personal Information page.
· New options will be added to enable users to select a non-binary gender in the TSA Secure Flight section of Travel Preferences.
· New options will be added to the gender field in the Travel Profile 2.0 API. This change will enable callers, such as TMCs and App Center partners, to provision (write) and receive (read) the new non-binary gender values.
Business Purpose / Client Benefit
These changes:
· Enable users to enter information into SAP Concur solutions that is consistent with their identity.
· Enable SAP Concur solutions to address a user by their preferred name.
· Ensure that information in SAP Concur solutions matches a user's government-issued identification.
· Ensure that travel documents such as airplane tickets purchased through SAP Concur solutions display information that is consistent with other required documents.
[bookmark: _Toc103933644]Implemented and Planned Changes
SAP Concur has implemented or plans to implement the following changes overtime beginning in April 2022 and continuing throughout 2022. 
April 2022 Release
Web UI Page Header
[bookmark: _Hlk100142441]The greeting on the Concur home page, "Hello <First Name>" was removed in April. The greeting included the name from the First Name field in the end user's user account.
Previously
The greeting "Hello, <First Name>" was included on the SAP Concur homepage.
[image: ]
With the April 2022 Release
The greeting is no longer included.
[image: ]
Mobile App
Previously
Prior to the April 2022 release, the menu in the Mobile app included the first and last names from the respective fields in the user's user account.
[image: ]
With the April 2022 Release
With the April 2022 release, no name is included at the top of the Mobile app menu.
[image: ]
Web UI Profile Menu
Beginning with the April release, if a user specifies a preferred name on the Profile – Personal Information page in Profile Settings, when they click on Profile in the web version of SAP Concur solutions, their preferred name and last name is displayed. 
[image: ]
If the user has not specified a preferred name, their first and last names from their user account information will be displayed.
May 2022 Release
My Profile - Personal Information – Preferred Name
Preferred Name Field
Prior to the May 2022 release, a Nickname field was included on the My Profile – Personal Information page. With the May 2022 release, this field will be replaced by the Preferred Name field.
[image: ]
Preferred Name in Import and Extract Files
With the May 2022 release, the Nickname fields in import and extract files will be renamed to Preferred name.
Employee Travel Addendum Import 350
The Preferred Name field will replace the Nick Name field in Employee Travel Addendum Import 350.

[image: ]
User Import
The Preferred Name field will replace the Nickname field in User Import.
[image: ]
Import Data
The Preferred Name field will replace the Nickname field in the user general information template.
[image: ]
Previously downloaded templates containing the Nickname field will continue to be processed.
Future Releases
Title List
In a future release, a new gender non-binary option, Mx (pronounced "Mix"), will be added to the list in the Title list.
Travel Preferences TSA Secure Flight
Currently, users see two options under Gender in the TSA Secure Flight section of Travel Preferences. 
[image: ]
In a future release, users will have two additional options under Gender: undisclosed (x) and unspecified (u). 
When selecting a gender option, users should choose the option that matches the government-issued ID they use when travelling.
Web UI Profile Menu
When users with permission to act on behalf of another user—for example, Travel Arrangers and Delegates—search for and act as another user, they will see the preferred name of the user they are acting on behalf of in the search field and at the top of the Profile menu.
[image: ]   [image: ] 
Configuration / Feature Activation
These changes will occur automatically over time. Users might need to update the information on the My Profile – Personal Information page after the changes are implemented. 
For more information, refer to the Preferred Name and Nonbinary Gender Options fact sheet.
[bookmark: _Toc103933645]SAP Concur Support
[bookmark: _Toc103933646]Suggested Solutions Migration

	Information First Published
	Information Last Modified
	Feature Target Release Date

	November 5, 2021
	May 13, 2022
	March 10, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933647]All Products | All Editions
Overview
On March 10, 2022, SAP Concur solutions replaced the Solution Suggestions platform with the SAP Continuous Influence – Improvement Requests program. 
This change provides a better user experience and a single place for Authorized Support Contact (ASC) users to engage with all SAP Concur Customer Influence programs. 
[bookmark: _Int_kC1IvMTz]ConcurGov customers will no longer see the Solution Suggestions section on the Support Portal. Customers can contact their Account Manager for more information.
For more information about this new program, refer to SAP Continuous Influence Sessions.
Business Purpose / Client Benefit
In addition to offering a better tool with more functionality, SAP Concur solutions has enhanced the entire process of how improvement requests are reviewed, considered, and prioritized. 
End-User Experience
Before Update
[image: ]
After Update
[image: ]
Configuration / Feature Activation
The change occurred automatically; there are no additional configuration or activation steps.
[bookmark: _Toc103933648]Security
[bookmark: _Toc103933649]Some TLSv1.2 Ciphers No Longer Supported (Feb 1, 2022)

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 13, 2021
	January 14, 2022
	February 1, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933650]Travel, Expense, Invoice, Request | All Editions
Overview
Beginning on February 1, 2022, SAP Concur solutions will no longer support connections to *.concursolutions.com and * api.concursolutions.com that use the following TLSv1.2 ciphers:
	Akamai/OpenSSL cipher name
	IANA cipher name

	AES256-GCM-SHA384
	TLS_RSA_WITH_AES_256_GCM_SHA384

	AES128-GCM-SHA256
	TLS_RSA_WITH_AES_128_GCM_SHA256

	ECDHE-RSA-AES256-SHA384
	TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384

	ECDHE-RSA-AES128-SHA256
	TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256

	ECDHE-RSA-AES256-SHA
	TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA

	ECDHE-RSA-AES128-SHA
	TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA


To ensure that connections to *.concursolutions.com and * api.concursolutions.com are not disrupted, clients and partners who connect to *.concursolutions.com and *api.concursolutions.com through an application that uses a retired cipher must update the application to a supported cipher before February 1, 2022.
Business Purpose / Client Benefit
This update provides ongoing security for our products and services.
Confirming Supported Ciphers
The following ciphers included in the ak-akamai-2020q1 cipher profile are supported:

	Akamai/OpenSSL cipher name
	IANA cipher name

	TLS-AES-256-GCM-SHA384
	TLS_AES_256_GCM_SHA384

	TLS-CHACHA20-POLY1305-SHA256
	TLS_CHACHA20_POLY1305_SHA256

	TLS-AES-128-GCM-SHA256
	TLS_AES_128_GCM_SHA256

	ECDHE-RSA-AES256-GCM-SHA384
	TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384

	ECDHE-RSA-AES128-GCM-SHA256
	TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256

	ECDHE-RSA-CHACHA20-POLY1305
	TLS_ECDHE_RSA_WITH_CHACHA20_POLY1305_SHA256


If your cipher suite includes both supported and unsupported ciphers, connections to *concursolutions.com through a web browser will not be disrupted. During the process of establishing the connection, the *concursolutions.com server will choose the most secure cipher in your cipher suite.
You can confirm that your cipher suite includes a supported cipher by cross-referencing the Akamai/OpenSSL cipher name with the IANA cipher name in the ak-akamai-2021 (default) column in the following table. 
Supported ciphers are indicated with a check mark.
[image: ] 
Testing Ciphers
The following procedure is intended for use by system administrators who want to test whether their cipher suite configuration will work correctly when connecting to SAP Concur solutions after support for the ciphers listed above has been removed. 
This procedure configures the system admin's local machine to connect to an akamai staging environment where support for the listed ciphers has already been removed. 
Summary of the procedure:
· Retrieve the IP address of the akamai production environment.
· Retrieve the IP address of the akamai staging environment.
· Redirect navigation to concursolutions.com to the akamai staging environment by editing the local Hosts file.
· Test a connection to concursolutions.com.
Confirm Your Cipher Suite is Working Correctly
Retrieve the IP Address of the Akamai Production Environment
1. Ping www.concursolutions.com
Windows: Open a Command Prompt window, type “Ping www.concursolutions.com” and then press Enter.
Mac: Open Terminal, type “Ping www.concursolutions.com” and then press Enter.
Example response
Pinging e7868.b.akamaiedge.net (23.46.104.197): 56 data bytes
64 bytes from 23.46.104.197: icmp_seq=0 ttl=50 time=125.070 ms
64 bytes from 23.46.104.197: icmp_seq=1 ttl=50 time=111.866 ms
64 bytes from 23.46.104.197: icmp_seq=2 ttl=50 time=111.967 ms
64 bytes from 23.46.104.197: icmp_seq=3 ttl=50 time=112.435 ms
Copy the highlighted address in the response.
Example address
e7868.b.akamaiedge.net
Retrieve the IP address of the akamai staging environment
1. In the Command Prompt or Terminal window, ping the copied address, but with “-staging” appended to “akamaiedge”.
Example Ping command
Ping e7868.b.akamaiedge-staging.net
Example response
Pinging e7868.b.akamaiedge-staging.net (104.76.225.252): 56 data bytes
64 bytes from 104.76.225.252: icmp_seq=0 ttl=50 time=118.809 ms
64 bytes from 104.76.225.252: icmp_seq=1 ttl=50 time=242.459 ms
64 bytes from 104.76.225.252: icmp_seq=2 ttl=50 time=112.145 ms
64 bytes from 104.76.225.252: icmp_seq=3 ttl=50 time=114.994 ms
Copy the highlighted IP address in the response.
Example IP address
104.76.225.252
Update the Local Hosts File
MAC:
1) Open Terminal
2) Type “sudo nano /private/etc/hosts” and then press Enter.
[image: ]
If prompted, enter your administrator password.
3) After the comments at the beginning of the file, add the IP address you copied in step 4, followed by “www.concursolutions.com”.
Comments are preceded with a hashtag (#). Your entry should not include the hashtag.
Example entry
104.76.225.252 www.concursolutions.com
4) Save the file (Ctrl-o) and close Terminal (Ctrl-x).
Windows:
Launch Notepad as administrator by typing “Notepad” into the Windows search bar, right-clicking Notepad in the search results, and then clicking Run as administrator.
[image: ]
If prompted, click Yes in the User Account Control window.
5) In Notepad, click File and then click Open.
6) Navigate to C:\\Windows\System32\drivers\etc and then, to the right of the File name field, choose All Files (*.*) from the menu.
[image: ]
7) Open the hosts file.
8) After the comments at the beginning of the file, add the IP address you copied in step 4, followed by “www.concursolutions.com”.
Comments are preceded with a hashtag (#). Your entry should not include the hashtag.
Example entry
104.76.225.252 www.concursolutions.com
[image: ]
9) In the File menu, click Save.
Connect to *concursolutions.com from the Local Machine
After configuring your local hosts file to direct connections to *concursolutions.com to the akamai staging environment, connect to *concursolutions.com from the local machine through the method you need to test. 
Your system administrator might need to test connections to *concursolutions.com made via an API call, connected application, or by navigating to the sign-in page through a web browser and signing in as an SAP Concur user.
Configuration / Feature Activation
To ensure that connections to *.concursolutions.com and * api.concursolutions.com are not disrupted, any applications that use an unsupported cipher must be updated to use a supported cipher before February 1, 2022.
If your cipher suite includes both supported and unsupported ciphers, connections to *concursolutions.com through a web browser will not be disrupted. During the process of establishing the connection, the *concursolutions.com server will choose the most secure cipher in your cipher suite.
[bookmark: _Toc103933651]Test Entities | Production Sandbox Environment
[bookmark: _Toc103933652]**Ongoing** Most Recently Used Lists Not Migrated

	Information First Published
	Information Last Modified
	Feature Target Release Date

	September 2021 
	January 21, 2022
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933653]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Due to the architectural changes that SAP Concur must make to support this move, when PSEs are migrated to the new environment, some Most Recently Used (MRU) list items within the PSE will not be migrated.
MRU lists consist of recent selections made by the user. These lists are generated overtime as users interact with various menus and other defined lists and they will be regenerated after the PSE is migrated to the new environment.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs benefit from the same stability, monitoring capabilities, and level of performance as production entities.
End-User Experience
After the migration, some MRU lists that were generated prior to the migration will be empty. These lists will be regenerated automatically through the normal use of the PSE.
The following screenshots show some examples of MRU lists that will be impacted by the migration:
Create New Expense in Concur Expense
[image: ]
New Segment in Concur Request
[image: ]
Configuration / Feature Activation
This change occurs when a PSE is migrated to the new AWS environment; there are no configuration or activation steps. The MRU lists will be regenerated with normal user of the entity.
[bookmark: _Toc103933654]**Ongoing** Production Sandbox Environment Login Updates

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 2021 
	January 21, 2022
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933655]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Today, a user can maintain the same login ID for their test and production entities because they are in separate environments. With the plan to migrate both test and production entities to the same AWS production environment in the future, this will no longer be possible since each login ID must be unique. 
While there is no action required for clients regarding this update, we want to ensure clients are aware of it because the change will be visible in certain areas of PSEs. To account for this change, SAP Concur will append all PSE login IDs with a ".uat” domain during both migration and user creation to ensure they are unique and do not conflict with any existing production login ID. For example, johnsmith@123.com will become johnsmith@123.com.uat.
IMPORTANT: No changes will made to the login IDs in the current implementation environment in our private data centers.

This process will occur in the background during both the migration and user creation processes. Because SAP Concur will manage this process, users will NOT have to make any changes to their login ID. 

Migrated users will still use the same implementation URL and login ID they used prior to the AWS migration. 

New clients will use the production URL with the appended login ID, which will include the appended domain (for example, johnsmith@123.com.uat). 
This change will help to safeguard against any conflicts with production login IDs. 
User Creation: Additionally, clients can use the exact same employee import files as they would in production. The uat domain will also be applied to all aspects of user creation: FTP import, Excel import, entity restore, and more.
Extracts: When generating accounting extracts or financial integration documents, SAP Concur will automatically remove the uat domain from login IDs that were appended during user creation. This will help to generate realistic extracts without requiring any actions from the clients, such as removing the appended domain.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs will benefit from the same stability, monitoring capabilities, and level of performance as production entities.
Configuration / Feature Activation
These changes occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc103933656]**Ongoing** Unique Address Required for PSE Email Verification

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 2021 
	January 21, 2021
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933657]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
When PSEs are migrated to the AWS production environment, verified emails from the existing PSE will not carry over to the new PSE. As a result, when users test verified email functionality in a future PSE, it is recommended that the employee uses an email that is different from the email configured in their production entity. This process is required as the email in the existing PSE was most likely already verified in production and, therefore, cannot be verified in another entity.
With respect to user email addresses, the Receipt Recognition service validates user email addresses and as such, only one instance of an email address can be associated with a user account. To test in production, clients will be required to utilize alternate email addresses that are not currently associated with any production user account. If a client attempts to set up a test account in production using an email address already associated with a corresponding user profile, it will fail the validation process.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs will benefit from the same stability, monitoring capabilities, and level of performance as production entities.
Admin Experience
BEFORE – Existing Email in Existing PSE
[image: Before screenshot of Existing Email in Existing Test Entity]
AFTER – New Email in New/Future PSE
[image: After screenshot of New Email in New/Future Test Entity]
Configuration / Feature Activation
These changes occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc103933658]Planned Changes
[bookmark: _Hlk92890624]The following features and changes are targeted for future releases. SAP Concur solutions reserves the right to postpone implementation of – or completely remove – any enhancement/change mentioned here. 
[bookmark: _Toc46229145][bookmark: _Hlk523311325][bookmark: _Toc478727899][bookmark: _Toc103933659]Concur Open
[bookmark: _Toc103933660]**Planned Changes** Japanese Translation Available (Jun 2)

	Information First Published
	Information Last Modified
	Feature Target Release Date

	May 13, 2022
	--
	June 2, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933661]All Products | Professional & Standard
Overview
Beginning June 2, 2022, the ability to switch between English and Japanese will be added to the SAP Concur Open and SAP Personalized Concur Open pages.
[bookmark: _Hlk103170773]In addition, you will be able to set English or Japanese as your preferred language on the Set Notification Preferences page.
Business Purpose / Client Benefit
This change eliminates the current manual translation process and improves the customer experience.
End-User Experience
When an end user navigates to the SAP Concur Open page by clicking the link to Service Status in the concursolutions.com page footer, a new language icon is available to the left of the SAP logo in the upper right corner of the SAP Concur Open page. 
[image: ]
The new icon also appears on the SAP Personalized Concur Open page.
[image: ]
When the user clicks on the icon, they can choose to set the page language to either English or Japanese.
[image: ]
In addition, on the SAP Personalized Concur Open page, after clicking Subscribe to Notifications, they can set their preferred notification language to English or Japanese.
[image: ]
Configuration / Feature Activation
This change occurs automatically.
[bookmark: _Toc103933662]Fax Feature
[bookmark: _Toc103933663]**Planned Changes** Fax Feature to be Decommissioned

	Information First Published
	Information Last Modified
	Feature Target Release Date

	November 2021
	January 14, 2022
	October 1, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933664]Expense, Invoice | Professional & Standard
Overview
On October 1, 2022, the Concur Fax Feature will be decommissioned.
[bookmark: _Hlk86919337]The Fax feature was retired in 2020. Clients onboarded after July 15, 2020 do not have access to this feature. Among clients with access, very few use the feature regularly and, among those that use it, use has declined steadily.
Business Purpose / Client Benefit
Removal of the Fax feature improves the security, performance, and scalability of SAP Concur solutions. 
In addition, The Concur Fax Feature attaches files only at the header level of expenses and invoices. As a result, clients who use the Fax Feature cannot take advantage of recent innovations that apply only to images and attachments at the line-item level.
End-User Experience
Users will no longer have the option to print Fax cover pages from within Concur Expense or Concur Invoice and they will no longer have the ability to fax images to SAP Concur for attachment to expenses or invoices.
Configuration / Feature Activation
This change occurs automatically; there are no configuration steps. 
Additional information about this change will be made available over the coming months.
[bookmark: _Toc79737887][bookmark: _Toc103933665]Financial Integration
[bookmark: _Toc103933666]**Planned Changes** Sage Accounting to be Retired

	Information First Published
	Information Last Modified
	Feature Target Release Date

	April 15, 2022
	--
	July 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933667]Expense, Invoice | Standard Edition
Overview
In July 2022, SAP Concur solutions plans to retire the Sage Accounting integration with Concur Expense and Concur Invoice.
This change does not impact the Sage Intacct integration.
Business Purpose / Client Benefit
This integration offering has not been adopted by any SAP Concur clients.
Configuration / Feature Activation
This retirement will occur automatically.
[bookmark: _Toc103933668]Help Menu
[bookmark: _Hlk96071113][bookmark: _Toc103933669]**Planned Change** Consolidation of Resources Under Help Menu

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 18, 2022
	May 13, 2022
	June 30, 2022 and Future release

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933670]All Products | All Editions
Overview
In June 2022, SAP plans to begin consolidating SAP Concur help resources under the Help menu in SAP Concur solutions. These changes will occur in two phases:
· Phase 1 -Targeted for June 30, 2022: In addition to the help content that is currently available from the Help menu, SAP Enable Now will be accessed from the Help menu.
For more information about support for SAP Enable Now, refer to the **Planned Changes** Support for SAP Enable Now release note in this document.
· Phase 2 – Targeted for a future release: The question mark icon (?) that currently provides access to user assistance, video tutorials, and tools for contacting support will be removed and those items will be accessed from the consolidated Help menu.
For more information about user assistance for admins and end users, refer to the User Assistance for Admins and End Users fact sheet.
Business Purpose / Client Benefit
These changes will improve ease of use and simplify the SAP Concur user interface by providing a single point of access to help resources.
User Experience
When all changes have been implemented, new options will be available in the Help menu—for example, if User Assistance for End Users or SAP Enable Now are enabled, a link to access those resources will appear in the Help menu.
Configuration / Feature Activation
These changes will be implemented automatically.
[bookmark: _Toc103933671]SSO Management
[bookmark: _Toc103933672]**Planned Changes** New Checkbox to Hide SSO Sign-In Option

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 11, 2022
	May 13, 2022
	June 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933673]Travel, Expense, Invoice, Request | Professional & Standard
Overview
SAP Concur plans to add a checkbox to the Add IdP Metadata and Edit IdP Configuration dialogs. The checkbox will enable an SSO administrator to prevent a specified SSO sign-in method from being presented to users as a sign-in option on the concursolutions.com sign-in page. 
In addition, SAP Concur plans to add a column to the table in the IdP Metadata section of the Manage Single Sign-On page that will indicate whether the checkbox to hide the SSO sign-in option is enabled (checked) or disabled (unchecked) for each configured sign-in method.
Users will still be able to sign-in via the method through other navigation paths as outlined by their company. 
Business Purpose / Client Benefit
The addition of this checkbox gives the SSO administrator greater control over how end-users sign in to their SAP Concur solutions.
SSO Admin Experience
When the admin navigates to the Manage Single Sign-On page, if SSO sign-in methods are configured, the new column indicates whether the method is available to end users or hidden from them.
When an admin clicks Add or Edit in the IdP Metadata section, the new checkbox is available at the bottom of the Add IdP Metadata or the Edit IdP Configuration dialog.
The SSO sign-in option can be enabled (checked) and disabled (unchecked) in the Edit IdP Configuration dialog.
Configuration / Feature Activation
The checkbox will be added to the Add IdP Metadata and Edit IdP Configuration pages automatically.
[bookmark: _Toc103933674]**Planned Changes** Option to Provide URL to IdP Metadata to be Removed

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 11, 2022
	February 18, 2022
	Q2 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933675]Travel, Expense, Invoice, Request | Professional & Standard
Overview
In a future release, SAP Concur plans to remove the Provide link to your IdP's metadata field from the Add IdP Metadata dialog.
Business Purpose / Client Benefit
In order to use the Provide link to your IdP's metadata field, clients must first open a support ticket to have the URL added to the SAP Concur allow list. These additional steps do not support the goal of making the SSO management process self-service for our clients.
SSO Admin Experience
When the admin navigates to the Manage Single Sign-On page and then clicks Add in the IdP Metadata section, they will no longer see the Provide link to your IdP's metadata field in the Add IdP Metadata dialog.
The admin will still have the ability to upload IdP metadata by clicking Upload XML File.
Configuration / Feature Activation
The field will be removed from the Add IdP Metadata page automatically.
More information about this change will be included in future release notes.
[bookmark: _Toc103933676]User Assistance
[bookmark: _Toc103933677]**Planned Changes** Support for SAP Enable Now

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 11, 2022
	May 13, 2022
	June 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933678]Travel, Expense, Invoice, Request | Professional & Standard
Overview
In late June, SAP plans to add support for SAP Enable Now with SAP Concur solutions. 
Business Purpose / Client Benefit
This change will enable clients to use SAP Enable Now to create user assistance content to improve user adoption and increase efficiency with SAP Concur solutions.
Configuration / Feature Activation
After support for SAP Enable Now has been added to SAP Concur solutions, clients who have User Assistance enabled for their SAP Concur solutions will be able to enable and disable SAP Enable Now on the SAP Concur User Assistance page.
More detailed information about this feature will be included in a future release note.
[bookmark: _Toc103933679]User Export and Import
[bookmark: _Toc103933680]**Planned Changes** User Export and Import Improvements

	Information First Published
	Information Last Modified
	Feature Target Release Date

	April 22, 2022
	--
	Q3 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc103933681]Expense, Invoice, Request | Standard Edition
Overview
SAP Concur plans to implement improvements to the user export/import experience. Improvements include, but are not limited to:
· Improvements to the downloadable user data template including tooltips and dropdown lists
· Removal of the 1000 user maximum for imports and exports of user data
· The addition of a new Manage Users via a Spreadsheet page
Business Purpose / Client Benefit
These improvements increase the ease of use and experience of the user import and export processes.
Admin Experience
On the Users page in Product Settings, when the admin clicks Add Users > From Spreadsheet, the admin sees the new Manage Users via a Spreadsheet page.
[image: ]
[image: ]
On the Manage Users via a Spreadsheet page, the admin can export, update, and import user data. When they export the spreadsheet, they will see new tooltips and, where applicable, dropdown lists in the spreadsheet. In addition, they will no longer be limited to downloading 1000 rows of user data.
Initial Release Opt-In Phase and Survey
During the initial release phase, clients will be able to opt-in to the new experience and will have the option to provide feedback on the experience through a survey. 
Configuration / Feature Activation
This new user export/import experience will be automatically available. During the initial release phase, clients will be able to opt-in to the new experience.
[bookmark: _Toc510082427][bookmark: _Toc12880017][bookmark: _Toc46229154][bookmark: _Toc11147478][bookmark: _Toc103933682]Client Notifications
[bookmark: _Toc69211924][bookmark: _Toc480899347][bookmark: _Toc483562026][bookmark: _Toc484092107][bookmark: _Toc480899345][bookmark: _Toc483562024][bookmark: _Toc484092109][bookmark: _Toc510082430][bookmark: _Toc514338227][bookmark: _Toc12880020][bookmark: _Toc46229157][bookmark: _Toc103933683]Accessibility
[bookmark: _Toc69211925][bookmark: _Toc103933684]Accessibility Enhancements
SAP implements changes to better meet current Web Content Accessibility Guidelines (WCAG). Information about accessibility-related changes made to SAP Concur solutions is published on a quarterly basis. You can review the quarterly updates on the Accessibility Updates (English Only) page.
[bookmark: _Toc103933685]Subprocessors
[bookmark: _Toc480899346][bookmark: _Toc483562025][bookmark: _Toc484092110][bookmark: _Toc510082431][bookmark: _Toc514338228][bookmark: _Toc69118207][bookmark: _Toc103933686]SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available from the SAP Sub-processors / Data Transfer Factsheets page.

To access the SAP Concur Sub-processors List:
1. Click the following link to navigate to the SAP Sub-processors / Data Transfer Factsheets page:
SAP Sub-processors / Data Transfer Factsheets
Sign in to the SAP Support Portal using your Support User ID (S-user) and password.
SAP customers must sign in to the SAP Support Portal using their Support User ID (S-user) and password. For information about S-User IDs, refer to Your New Support User ID (S-user). 
On the SAP Sub-processors / Data Transfer Factsheets page, type "Concur" in the Search field.
In the Title column, click SAP Concur Sub-processors List.
If you have questions or comments, please reach out to: Privacy-Request@Concur.com 

[bookmark: _Toc77840903][bookmark: _Toc103933687]Supported Browsers
[bookmark: _Toc77840904][bookmark: _Toc103933688]Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will also appear in the Shared Planned Changes release notes.
[bookmark: _Toc90037239][bookmark: _Toc103933689]Additional Release Notes and Other Technical Documentation
[bookmark: _Toc90037240][bookmark: _Toc103933690]Online Help
Any user can access release notes, setup guides, user guides, admin summaries, monthly browser certifications, supported configurations, and other resources via online Help or directly on the SAP Help Portal.
Use the links in the Help menu in the app, or search for your SAP Concur product (Concur Expense, Concur Invoice, Concur Request, or Concur Travel) on the SAP Help Portal (https://help.sap.com) to view the full set of documentation for your product.
[bookmark: _Toc90037241][bookmark: _Toc103933691][bookmark: _Toc530557893]SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP Concur support portal.
If you have the proper permissions, Contact Support appears on the Help menu. Click to access the SAP Concur support portal, then click Resources. 
Click Release/Tech Info for release notes, technical documents, etc. 
Click Webinars for recorded and live webinars.
[image: P1891#yIS1]
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Travel Addendum Import (Record Type 350) Format

The 350-level record is used with either the 305-level (Expense & Travel user) or the 310-level (Travel only user) record block, or the user must already exist in the Expense database / system.

! The 350 record import functionality is not available if the Email login option is used.

Table 6: Data for record ID "TravelAddendumImport”

1 Transaction Type 350 Y. This is a static numeric value always equal to 350. It indicates the Record Type

2 Employee ID 48 characters maximum Y. Must match a 305-level record in this file

3 Name Prefix 60 characters maximum N Must contain these exact values (Lord, Lady, Sir, Mr, Miss, Ms, Mrs, Dr, Rev, Prof)
4 Name Suffix 60 characters maximum N Must contain these exact values (Jr., Sr., I, II, III, IV, V, VI)

5 Nick Name 60 characters maximum N Informal, non-birth name employee is known as.
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Prefix Name N If provided, must contain one of these exact values (Lord, Lady, Sir, Mr., Miss, Ms., Mrs., Dr., Rev.)
Suffix Name N If provided, must contain one of these exact values (Jr,, Sr., I, II, III, 1V, V)

Informal, non-birth name employee is known as.
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5 |User Information tab:
6 |Login ID is the Concur Travel Login ID of the user to be created or updated.

7 |Last Name, Middle Name, First Name, Name Prefix, Name Suffix should be filled in to match the user's legal name.
[ Preferred Nameean be given for 3 user that prefers to be called by something other than their frt name.

'user's birthday in M/D/YYYY format.
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#*Planned Changes**
Coming Q1 2022: Concur Solution Suggestions is evolving to the SAP Continuous Influence —
Improvement Requests platform. This change offers not only a better experience, but 2 single
place for you to engage with all of our Customer Influence programs.

Tolearn more, please visit our Continuous Influence information page.

Suggestions submitted after December 1, 2021 will not be reviewed in order to support this
change. If you have a great idea you'd like to share, make sure to come back here in Q1 to
submit your Improvement Request!
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IMPROVEMENT REQUESTS

Concur Solution Suggestions has evolved to the SAP Continuous Influence - Improvement
Requests platform.

SAP Continuous Influence invites you to suggest SAP product and feature improvements
directly to the product teams. You can submit new ideas, vote on existing submissions, and get
instant update notifications by following requests. opportunities, and other interesting topics.

Tolearn more, please visit our Continuous Influence information page
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Last login: Thu May 27 16:
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# Additionally, comments (such as these) may be inserted on individual
#lines or following the machine name denoted by a # symbol.

#

# For example:

#

# 102549497  rhino.acme.com # source server

# 38256310 xacme.com #x client host

# localhost name resolution is handled within DNS itself.
# 127001 localhost
# A localhost

104.76.225 252 www concursolutions.com
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